Table of Contents

Install V-Ray for Rhino ................................................................. 6
Activating V-Ray for Rhino ............................................................ 7
Before you Start Rendering .......................................................... 12
Understanding Default Settings ..................................................... 13
Render Options ............................................................................. 14
  Save and Load Option Settings
  Two ways to assign materials in V-Ray
Material Editor ................................................................................ 18
  Diffuse Layer
  Adding a new Material
  How to duplicate a material
  How to change the name of a material
  How to remove a material
  Others
Material Usage .................................................................................. 23
Add Lights ....................................................................................... 25
The Characteristics of Rectangular Light ......................................... 28
  Size does matter
  Shadows change according to the size
  Impact on reflective objects due to visible and invisible rectangle light
  Double Sided Option
Light Units
Material: Reflection Layer ............................................................... 32
  Adding Reflection Layer
  Fresnel Reflections
Reflections and Highlights ............................................................. 34
Other Parameters .............................................................................. 35
  Reflection Glossiness
  Reflection Filter
Refraction Layer ................................................................................ 37
  Add Refraction Layer
  Controlling the Amount of Transparency
  The color of refractive materials
  Fog Settings Explained
  Adjusting Refraction IOR
  The Glossiness of Refractive Materials
  Shadows of Refractive Materials
  Double-Sided Material
  Translucent Material
Emissive Materials ............................................................................. 45
  Add Emissive Layer
  Adjust the Intensity
  Adjust the Color
  Emissive Textures
Texture Mapping ................................................................................ 49
  Projection Types and Adjustments
Bump Maps ...................................................................................... 53
Alpha Contribution ............................................................................ 55
Displacement ...................................................................................... 56
  Adding Displacement
  Displacement Parameters
  Adjusting Displacement
Caustics

- What are Caustics?
- Examples

Color Mapping

- The Function of Color Mapping
- Types of Color Mapping

Adaptive Subdivision Control

- Adaptive Subdivision Sampler
- Fixed Rate Sampler
- Adaptive DMS Sample

Mesh Settings

- Setting Custom Render Mesh

Resolution of the Image

- Image size setting
- Saving your image

V-Ray Frame Buffer

- Render image window toolbar

Distributed Rendering

- Setting Up the V-Ray Distributed Rendering Spawner
- Finding the IP address of the slave Computer
- Starting the DR Spawner
- Connecting to Slave Machines
- Some Considerations for Distributed Rendering

Sample Materials
1. Make sure that Rhino is closed and begin the installation process. Click Next.

2. Click “I accept the terms of the license agreement”, then click next.

3. Choose complete setup type to install all program features, click next to continue.

4. Click Install to begin the installation. If you want to change anything, click Back.

5. Install the program.

6. When the installation has successfully installed, click finish.
1. After installation, open Rhino. Now the Product license dialogs will ask you to choose one of the three options.

2. If you haven’t purchased V-Ray for Rhino, you can run a demo by selecting the option “I wish to demo this product”.

If you have already purchased V-Ray for Rhino, you can choose one of the two other options, floating license server or standalone license.

Standalone License

1. Select “I have purchased a standalone license and would like to use that” and click “next”.

2. Enter your serial number, then click next. Activation usually takes a few seconds.

Sometimes, proxy servers or firewalls can block the online activation. You may receive this error during the installation process: “Failed to contact web service”. You can activate your license offline. For instructions on how to do this, please see the “Offline Activation” section.
Floating License Server

Setting up the License Server

1. Before you use the Floating License Server, you need to run the Floating License Manager on the computer you will use as the server. Click Start, then “All Programs”, under “ASGvis, LLC” folder select “Launch Floating License Manager”. Click “Add existing license”.

2. Select the appropriate product and click OK.

3. Enter the Serial Number, select the amount of seats that you have and click “Submit”. If you have more than one license you have to repeat step 1 thru 3.

4. After you have finished with your licenses, click “Start license Server”. You will see the icon in the desktop toolbar.
Setting up a computer on the Network

1. After setting up the Floating License Manager, start Rhino and select “I have a floating license server and would like to use that”, click “Next”.

2. In the “primary license server” section enter the name of the computer that you have as the Floating License Server. If you have more than one server, enter the other names in the “Alternate license server 1 and 2”. Then click “OK” to finish. Click “OK” again to update the settings.

Alternate setup for a computer on the Network

1. Another method to setup the License Server is click the “Start” menu then select “All Programs”, click on “ASGvis,LLC” and choose “Set License Server”. Select the appropriate product and click OK.

2. In the “primary license server” section enter the name of the computer that you have as the Floating License Server. If you have more than one server, enter the other names in the “Alternate license server 1 and 2”. Then click “OK” to finish. Click “OK” again to update the settings.
Sometimes, proxy servers or firewalls can block the online activation. You may receive this error during the installation process: “Failed to contact web service”. You can activate your license offline.

### Offline Activation

**Web Activation**

1. If you have to activate your V-Ray for Rhino by “Offline Activation”, you will see this “Error” window.

![Error]

Failed to connect with service. This can happen when your computer is not connected to the internet or another process is denying the activation process access to the internet. If you are connected to the internet you may wish to try our web page activation process. It is less likely to be blocked. If you are not on the internet you will need to use our offline activation.

2. If you are connected to the internet you can try our “Web Activation”. Click on “Web Activation”. A box will appear. Click on “Activate now”.

![Web Activation]

Web-page activation

Following the link will bring you to the web-page activation form. If clicking the link fails to launch your browser you will need to copy the link and paste it into the browser manually.

When you reach the activation site you will need to enter the required information and submit it. After the form is verified it will produce a response code. Copy and paste that code into the text field below and then click OK.

3. A link to our web page will appear. Fill out the information. Click submit.

![Web-page activation]

Web-page activation

Following the link will bring you to the web-page activation form. If clicking the link fails to launch your browser you will need to copy the link and paste it into the browser manually.

When you reach the activation site you will need to enter the required information and submit it. After the form is verified it will produce a response code. Copy and paste that code into the text field below and then click OK.

4. It will give you a “Response Code”, copy and paste the response code to the box in the “Web-page activation” and click “OK”
**Offline Activation**

1. If you are not connected to the internet, you have to use the “Offline Activation” button. Click on it.

2. You will be prompted to save out a file. Save it to your desktop or somewhere easily remembered.

3. Send that file to support@asgvis.com. We will process your request and send your file back.

4. After receiving the new file you will need to save this file to your desktop, replacing the old file if it is there. Then choose “Import License”.

5. Select the file that was sent to you. You can then close the offline activation program.

6. Open the program you have just activated. If you encounter any problems please email us with a clear description of the error message and problem.
Before you start rendering with V-Ray for Rhino

When rendering an image with any rendering program, including V-Ray for Rhino, you must understand three main factors that will affect the image: Lighting, Materials, and Mapping. Lighting plays the most important role among these three. It will affect the color, shadow, reflection and refraction among every single object in the scene.

V-Ray for Rhino is a rendering engine equipped with Global Illumination (GI), which helps the users setup the lighting for entire scene easily. So they don’t have to spend a lot of time adjusting lighting location and brightness.

The concept of GI is very simple. Imagine a room has a window but no light in it. The natural light from the outside of the room comes in through the window so the room doesn’t look completely dark even though there is no light in it. Some people even call this the “lazy boy lighting”. Its purpose is allowing the users have the most natural light possible but without spending too much of time to achieve it.

V-Ray for Rhino also supports High Dynamic Range values, also called HDRI (High Dynamic Range Image). With a normal 24bit, 8bit per channel RGB image (Low Dynamic Range Image), the brightest white color you can get is R255, G255 and B255. But this is still thousands times lower than what the sun light can produce. With the HDR file format, users can have more control ranging from dark to bright. The HDR is a very special image file format. It usually starts with professional 360 degree photography, then transforms to 96bit full scene image by using professional HDR software. The benefit of using HDR is that you can use this full scene image as your render light source. It also can be used as the background rendering.

V-Ray for Rhino also supports regular image file formats as light source for GI.

However, it is still limited when using HDR image format to describe the lighting environment. Together with other regular image file format simulated lighting environments, it usually being used only as supporting lighting for the entire scene. That means adjusting the setting of major light sources is still a very important work in V-Ray for Rhino. We will discuss more about how to use lighting, materials and mapping later.
Rendering with the Default Settings
The Default Options in V-Ray for Rhino are set up so that certain elements of V-Ray are already enabled. This is good because certain aspects that are specific to V-Ray are already configured with a proper setting. However there are a number of elements which are contributing to the final render, and it is important to know what they are so that unwanted results are avoided when we start adjusting the render options ourselves.

Key Elements in the Default Settings
There are three main elements specific to V-Ray that are creating some of the aspects of the default render. These elements are Indirect Illumination, the V-Ray Sun and Sky, and the V-Ray Physical Camera. These elements will be explained very briefly here, and you can reference other chapters in the book for a detailed explanation of these elements.

Indirect Illumination is simply light that does not come directly a light source. In V-Ray this typically references two types of light; Global Illumination and Bounced light. Global Illumination is simply a dome of light that is emitted around the scene, and this can make setting up lighting very quick and easy. Bounced light is simply the light energy that is bounced from a surface. This bounced light is what allows V-Ray to create high-quality renderings. For a more in depth explanation of Indirect Illumination please refer to page 66.

The V-Ray Sun and Sky is a physically accurate lighting model allowing for easy recreation of the affects of the Sun and Sky. This is an excellent tool for setting up exterior renderings with a sun. Due to the nature of the model in which the sun and sky are based off of, you will find that under standard conditions the sun and sky will be extremely bright. Because of this the V-Ray Physical Camera is used to expose the scene and brings the rendered image to a desirable level.

The V-Ray Physical Camera is modeled after a real-world camera and can be used to expose a scene. In the real world, lighting is different in many situations, and because of this a photographer will use the capabilities of the camera to properly expose the image. Proper exposure means that the image is not overly bright or too dark. When creating renderings this gives us the opportunity to set our lighting as it would be in the real world (in this case it is the Sun and Sky) and adjust our camera settings until we achieve the desired result.

The detailed explanations of the Sun and Sky and the physical camera are on page 85 and 88.
Open V-Ray for Rhino -- Render Options

The V-Ray for Rhino Options controls all rendering parameters. You can open this Render Options from tag above or click directly on the VRay Options.

Save and Load Option settings

There are many Options settings in V-Ray for Rhino. Users can save the current settings, or save different files according to different scenes, different render quality settings, or different render engines.

From File>Save to save Options setting. Use .visopt as the file format. It's about 2KB in file size. When the Rhino file is saved, all changes in V-Ray Options setting will also be saved.

Use File>Load to load saved .visopt Options files. It will replace the current settings.Use Restore Defaults to restore the original V-Ray settings.

Open file Cups-Original.3dm. There are 3 cups and a very large floor in the file. All objects are not assigned to any material and there is no light in the scene as well. Please click the blue render icon from above directly and you will get this gray tone image without changing any setting in the V-Ray Options.
1. **Global Switches**

Please uncheck Hidden Lights and Default Lights under the Lighting section. Hidden Lights means hiding the lights from the scene. It is used when the users don’t want to see any light while modeling in the scene. When uncheck the Hidden Lights box, those hidden lights will not affect the V-Ray render. To prevent these hidden lights affect the final render output, we recommend you uncheck the Hidden Lights first.

Default Lights means V-Ray built-in lights. Users can not see nor edit these lights from the scene. If one uncheck the Default Lights and does not check the GI below, the render will turn out totally black.

We also recommend you check the Low thread priority under the Render section so that it won’t affect other program while rendering with V-Ray.

2. **Indirect Illumination**

Please check “On” under Indirect Illumination on, also called Global Illumination. We will explain those green dot items more later.

3. **Environment**

Environment controls the contract, color, and HDR of the Global Illumination.

Please check the boxes before GI and Background.

Please adjust those three items then select the blue render icon on the top. You will get the image with Global Illumination. Compare to the image without Global Illumination, you can see the objects don’t have dark shadow because the objects get light from all around.
Because the cups and floor are not assigned to any materials, V-Ray gives the objects Rhino's default white layer as material. To know how to assign the materials to the objects and make adjustments, we need to open the Properties tab.

**Two ways to assign materials in V-Ray**

1. Press Ctrl+A to select all the objects in the scene then click the Object under the Properties window to select material. The objects are assigned materials by layers now. Please click Plug-in, there will show three tabs of Browse, Edit and Create below.

   ![Material Assignments](image)

The image is in blue tone is because the default environment color of V-Ray is set in light blue of R-204, G224, B225. Please check the box under GI to enter the color selections. Change the Sat from 51 to 5. The color is changed to light blue of R250, G252, B255, which is very close to white. Click OK to exist then click on the blue render icon to color the image. The image color becomes very close to white like the image on the right.
2. Click the Browse button, in the choose material window, select Default_VRay_Material, then click apply.

3. Now the objects are applied with materials, so the Edit button is selectable. You can click on the Edit button to open the Material Editor to apply the materials.
Material Editor in V-Ray for Rhino

Material editor can be pulled out from the icon under V-Ray for Rhino tool box, from Material Editor from V-Ray tab, or by clicking the Edit button in Properties window.

V-Ray Material Editor

V-Ray for Rhino’s Material Editor has three parts:

A. Material Workplace shows all the selected materials. Right click to add, import, export, rename, Pack, remove, and select the objects with current materials, such as assigning current materials to the selected objects or to the selected layers, deleting materials that are not used in the scene, and adding layers with reflections, refractions to the materials.

B. Material Preview, the Update Preview button allows you to preview the adjusted materials.

C. Options for material control. The options change with the added scene materials in section A.

Click on Update preview button to update the preview image to current materials.
**Diffuse Layer**

Color: used to apply color on material. The "m" box on the right is used to apply pattern and arrange sequence.

Transparency: used to adjust the color transparency. Black is completely opaque and white is completely transparent.

---

**How to add new material:**

1. Right click on Scene Material, select Add new material, Add VRayMtl.
2. Right click on Scene Material, select Import new material to import a saved material file.
3. In the Properties window, click on Create button to add a new material.
How to duplicate a material:
Under Material Workplace, right click on the material you wish to duplicate and select Duplicate. This is another way to add a new material.

How to change the name of a material:
Right click on the name of the material you wish to change, and select Rename.

How to remove material:
Right click on the name of the material you wish to delete, and select remove. If the material being removed is applied to the objects in the scene, V-Ray will show a pop-up window to ask if you want to remove it for sure.
How to export material
Right click on the material you wish to export, and select export to export this material. The File extension is .vismat, the file is 1 KB. This file can be imported, packed or sent to other users later on.

How to import new material
Right click on the scene material and select import new material, then you can select the material you want.

How to pack material
Right click on the material you wish to pack and select pack, This feature is very usefull, because you can save the textures and a preview of your material in a single file.
Another three selections:

1. Select Objects by materials: Selects the objects in the scene with this material.
2. Apply materials to object(s): Applies this material to selected objects in the scene.
3. Apply materials to layer(s): Applies this material to selected layers. All the objects in the same layer will be applied with this material.

Any materials under the Scene Materials can be applied to objects by clicking “Browse” under Properties.

Purge unused materials: Right click on Scene Materials to select purge unused materials to remove materials which are not applied on the scene objects.

You can not use undo to undo the change in Material Editor.
Material Usage

01. Open Cups-GI.3dm file. Select all the objects. Under the Properties window, select material, check plug-in and click Create to add a new material. Material Editor will show a new material named DefaultMaterial under SceneMaterial.

02. Rename this new material as Ground.

The file sets V-Ray Options to GI and has GI environment light and background color. Hidden Lights and Default Lights are closed. Other options remain default.

03. Select Diffuse to enter color selections. V-Ray's default color is R-128, G128, B128. Change the color to light gray as: R230, G230, B230 then exit.

04. Right click on Ground material. Select Duplicate and rename as Cup_Orange.

05. Left click on the empty spot to deselect the objects. Go to Top view and select these cups from top left to bottom right. Then go back to Material Editor and right click on Cup_Orange and select Apply material to objects.

V-Ray automatically updates the changes of materials to the object, is not necessary to apply materials again.
06. Click on Diffuse and change the color to R255, G191, B0 (orange) and exit.

07. Render and see if you get the same result like the image on the right.

08. Duplicate the Cup_Orange material and rename it as Cup_Green. Repeat 06 and set the value to R127, G255, B178 and exit.

09. Apply this Cup_Green material to the bottom right cup.

10. Duplicate the Cup_Green and rename it as Cup_Red. Repeat 06 again and set the value to R255, G94, and B0 this time.

11. Select the cup on top and apply the Cup_Red material to it.

12. Render and see if you can get the same result as the image below.

13. Make another material and name it Cup_White and change the diffuse color to Val 230. Apply this material to the inner part of the cups and render.
Add Lights

We haven’t added any light to the scene so far. However, the render still looks good. The shadow is kind of smooth because we used GI as the only light source. So we still need to add more lights in order to have more depth to the image.

01. Right click and hold on the Spot Light icon from toolbar above. A secondary toolbar will pop out, select the fourth one from the left (Create Rectangular Light).

02. From Top view, follow the steps below to create Rectangular Light in the scene.

03. Start from bottom left and make your second left click to the bottom right of the scene.

04. To complete creating the light, make your third left click on the top left of the scene, approximately the same distance as between first and second spots.

05. Select this Rectangular light you just created.
06. Go to the Front view. Left click and hold right on top of the light and drag it to the top, approximately 5X of the height of the cup.

![Front view of light and cup](image)

07. Render it and you will get a very bright image like the one below. That's because the V-Ray's default setting of the Rectangular Light is set to No Decay. Please follow the steps below to adjust it.

![Rendered image](image)

08. Select the Rectangular Light. Under the Properties, click on Object and select Light.

![Light Properties](image)

09. Uncheck the No Decay. This will make the distance between the light and objects being considered while rendering. That means the object further away from the light will get less light and become darker. To make the object brighter, you can either increase the intensity of the light or move the light closer to the object.

![Light Properties](image)

10. When uncheck the No Decay, the default setting of the intensity is set to 1. Please change the Multiplier from 1 to 4.

![Light Properties](image)

11. Hit Render again and you will get a much better result like this one below.

![Better rendered image](image)
Here are some images with different intensities.
The Characteristics of Rectangular Light

Rectangular Light plays a very important role in V-Ray. Despite its easy of use, it also gets a smoother final result. Unlike the Spot Light, Rectangular Light doesn't have the worry about the angle of the light. It also allows reflective material to bounce the light around the scene. Other type of lights will not be seen in a reflective object. Below are some important characters about Rectangular Light.

Size does matter
See images below and you will find the size of the Rectangular Light has an affect its intensity.

Shadow changes according to the size.
Larger Rectangular Light spreads out to a larger area, so the shadow is not as clear as you will get from a smaller Rectangular Light.

Compare images below and you will see the differences between two different light sizes. The one on the left is rendered with smaller light.

If you want to have a stronger shadow, we do not recommend you set the intensity way high and make the light size really small. It's better to use a different light type in V-Ray. Please see dialogue box of how to create a Parallel Light later.
Impacts on reflective objects due to Visible and Invisible Rectangular Light

There is an Invisible option in Rectangular Light. It allows the light visible or invisible from the render image. See images below. The one on the left has the Invisible option unchecked so the light appeared in the image. When apply a reflective material to the object, the light will also being reflected on the object. The image on the right has the Invisible option checked. Thus, you don't see the light in the image or on the object with reflective material applied to it.

The default setting for Rectangular Light has the Invisible option unchecked. If you see any unusual dark shadow in your rendered image, please check if your camera is blocked by the Rectangular Light in the scene.

Double Sided Option

You can tell the direction of the light from the short line on one side of the Rectangular Light. Rotate the light and you can change the direction of the light.

The Double Sided option can turn the light direction from one side to both side of the light. Just like to create two lights with opposite directions. Move the light away from the floor or wall to avoid any black out area.

Double Sided option usually used when renders a big interior scene. It helps to lit up the space without using too many lights. Normally we don't use it when render a product scene. There will be more discussion about lighting and environment lighting later on.

The default has the Double Sided option unchecked. Of course, if you check and Invisible option, you will not see the light in those three images on the next page.
Pay attention to the size, location and intensity factors of Rectangular Light because they will affect the brightness and shadow clarity of your final result.

If the light is placed too far away and the subject is not bright enough, you can either increase the intensity or size of the light. On the other hand, you can lower the intensity or reduce the size of the light if you place the light too close or too bright. You will need to keep adjusting the size, location and the intensity of the rectangular light in order to get good lighting result.
Light Units

Intensity light unit allow you select diferent physical unit of the light. Usind the correct intensit unit will help you to get the correct result when you are using the Physical Camera. This take in consideration the units scale of the scene.

Values:

Scalar - means the final color of the light it is given by the color and multiplier of the light without any convertion.

Lumens - the total power of the visible light was mesured in lumens. The light's intensity does not depend on its size.

lm/m/m/sr - the light power calculated in lumens per square meter per steradies. The light's intensity depend on its size.

Watts - the light power calculated in watts. The light's intensity does not depend on its size. Does not work like a real light bulb. (Ex. real 100W light bulb emits between 2 and 3 watts as visible light.

w/m/m/sr - the total visible light power calculated in watts per square meter per steradian. The light's intensity depend on its size.
Material: Reflection Layer

This section is about how to add and edit the reflection layer. Please click on the red cup in the scene. Click on Edit button under Material selections in properties.

Adding Reflection Layer

1. Click on the “+” next to Cup_red under Scene Materials to pull out all the layers. Right click on Reflection Layer. Select “Add new layer” to add a new reflection layer for this material. There will show Reflection under the material control section, as it shows on the right.

2. To remove a new added layer, right click on the layer you wish to remove then select remove.

3. By Default the reflection layer has a fresnel map which varies the amount of reflection based on the viewing angle. If that map is removed then the reflection is constant over the whole material. Since the reflection color is set to white this leads to complete reflection on the whole material. This is a good setting for chrome or a mirror, but not most materials.

4. Now we will go through the specifics of the fresnel map. Click on Reflection on the right section, and then click on the m box to set reflection.
5. If it is not already enabled scroll down the box next to Type, and then select Fresnel. Fresnel IOR is to control the reflection intensity. Keep the default value of 1.55, then click Apply.

6. Click on the Material Preview again. The Material now has reflection quality with the same color on it.

6. Notice the “m” on the right side of the Reflection is now changed to “M”. That means the Map has some other characters associated with it now. Please use the same method and apply Fresnel to other colors and render it. The white spot on the cup is the Rectangular light from above.

7. Below image rendered with Fresnel IOR set to 2.5, it has more reflection and looks more like a metal texture now. The cup has some black reflection due to the default setting of the background color is black. Under V-Ray Option, change the color under Environment>Background to white and see what will you get.
**Fresnel Reflections**
Fresnel Reflections are a naturally occurring phenomenon that states that an object becomes more reflective the greater the angle at which it is seen. An example of this principle would be a window that is seen from straight ahead as opposed to at an angle. Through manipulating the Index of Refraction (IOR) the reflective characteristics of an object can be changed. A lower IOR means that a larger angle is needed between the observer and the surface before the object begins to reflect. A higher IOR means that a smaller angle is needed, which in turn causes the object to reflect sooner. To have your renderings be more physically correct it is recommended to have the IOR of an object correspond to its actual IOR.

Below are six rendered samples each with a different Fresnel IOR. The last one is a rendered with full reflection to create a chrome material.

![Fresnel Reflection Samples](image)

**Reflections and Highlights**
Wondering why V-Ray rendering engine doesn't have the highlight option built into it as previous rendering engine Flamingo? The truth is that the highlight is created by reflecting a very bright object or light in the scene. It also called lightsource.

Some rendering engines use Highlight to create lightsource if there isn't any lightsource in the scene. But current V-Ray for Rhino version does not support this option. So you must create Rectangular Light or other self lit object as lightsource for the scene.
Every object has certain degree of reflection. Some are very strong, and some weak. But this doesn’t mean we have to apply reflection to every single object in the scene because that will increase your rendering time significantly.

**Reflection Glossiness**

You don’t always get clear reflection from reflective material. Objects like matte finish metal, wood and some plastic materials do not reflect the light source clearly due to its uneven surfaces. This is because the uneven surfaces create many reflecting angles for light to bounce around. So the highlight is not as sharp if compared to reflection from smoother surfaces. The best way to create this kind of rendering quality is playing around the setting of both Highlight Glossiness and Reflection Glossiness.

The default value for both Reflection and Highlight Glossiness is 1, which means that the reflections will be perfectly sharp. Once the value is decreased below 1 the reflections begin to become blurry. A value of 0 would mean that the reflections are completely blurred, and this would look similar to a material without a reflection layer at all. Setting this for regular materials would cause extremely long render times. A good range for creating glossy reflections is between .5 and 1. At values below .5 the effect is similar to a material without reflections.

Below are results from combinations of various intensities of Reflection Glossiness and Fresnel IOR.
Reflection Filter
The filter color is used to apply color to reflections. You can see that by changing the filter color on each of the renderings below the color of the reflections change. The magnitude of this effect will change based on the strength of the reflections themselves. In the case of materials which are very reflective, filter color may be an effective way to change the object’s appearance.

Samples of Reflection Glossiness
Open file: Cups-Refraction Original.3dm. We are going to introduce how to add and edit the refraction layer. Select the red cup from above. Under Properties>Material, select Edit to edit the cup’s material.

Add Refraction Layer

1. Click on the “+” to the right of the Cup_Red, and then right click on Refraction Layers. Select Add new layer. You will see the Refraction layer added to the right of the window.

Controlling the amount of transparency

2. If you don’t see the transparency from the material preview window, that’s because the Transparency is set to black. Use this color to adjust the degree of Transparency. Click on the color and change it to white, which will give you 100% of transparency to the material.
3. Click on the Update Preview again and you will see the transparency, but without its original red color. When you set the transparency to 100% white, no matter what you have for diffuse color, it will not show up. It will render like right hand side image below.

The color of refractive materials
When you want to apply color to a refractive material, the best way to do this is through the Fog Color, which is located to the lower right of the Refraction dialog box.

4. Click on Fog Color and change it to the same color as the original Diffuse Color. Click on the Update Preview and you will see the red color show up on the material this time.

Image on the left is what you will get. Do the same changes to the other two colors and you will get the image looks like the one to the right. Under Render Options>Environment, change the background color from black to white and see what you will get this time.
**Fog Settings Explained**

The appearance of Fog depends on three parameters; Fog color, Fog Multiplier, and object size. The Fog color is a very important factor, and the wrong color can make it hard to achieve your desired effect. It is best to set your color to a very light or desaturated version of the desired color. The Fog multiplier will be determined by the Fog color and the object size. The object's size is important because Fog is created by calculating how much light penetrates an object. Therefore, a larger object will absorb more light than a smaller object. This means that a single setting will not necessarily produce the same effect from object to object. The image on the left is two spheres with the same material applied to them, but the sphere on the right is 4 times larger. The images below are tests of different multipliers with a saturated and desaturated color.

Fresnel IOR: 1.55  
Refract IOR: 1.55  
IOR: 1.55  
Fog Color: R244, G250, B230

<table>
<thead>
<tr>
<th>Fog Multiplier</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image 1" /></td>
</tr>
<tr>
<td>0.6</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image 7" /></td>
</tr>
</tbody>
</table>

Fresnel IOR: 1.55  
Refract IOR: 1.55  
IOR: 1.55  
Fog Color: R175, G250, B0

<table>
<thead>
<tr>
<th>Fog Multiplier</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
</tr>
<tr>
<td><img src="image13.png" alt="Image 13" /></td>
</tr>
<tr>
<td>0.6</td>
</tr>
<tr>
<td><img src="image19.png" alt="Image 19" /></td>
</tr>
</tbody>
</table>
Adjusting Refractions with Index of Refraction

IOR (Index of Refraction) is used to calculate among of the light refracted from transparent object. The newly added IOR default is set to 1.55. Please see the chart for typical objects' IOR value.

<table>
<thead>
<tr>
<th>Material</th>
<th>IOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0</td>
</tr>
<tr>
<td>Air</td>
<td>1.0029</td>
</tr>
<tr>
<td>Alcohol</td>
<td>1.329</td>
</tr>
<tr>
<td>Crystal</td>
<td>2.0</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.417</td>
</tr>
<tr>
<td>Emerald</td>
<td>1.57</td>
</tr>
<tr>
<td>Glass</td>
<td>1.517</td>
</tr>
<tr>
<td>Glycerin</td>
<td>1.472</td>
</tr>
<tr>
<td>Ice</td>
<td>1.309</td>
</tr>
<tr>
<td>Ruby</td>
<td>1.77</td>
</tr>
<tr>
<td>Sapphire</td>
<td>1.77</td>
</tr>
<tr>
<td>Water</td>
<td>1.33</td>
</tr>
</tbody>
</table>

Default set the Refraction IOR to 1.55; please refer to images below for setting of IOR to create desire material.

Please note that reflection and refraction IOR values are separate, but to achieve an accurate effect these values should be the same.
The Glossiness of Refractive materials

Both refractive objects and reflective objects have an option setting for Glossiness. The difference is that Reflection Glossiness only affects the surface, whereas Refraction Glossiness will have an effect on the object's transparency.

The Glossiness of a refractive object usually used to represent different types of glass, for example, frosted glass. The refractions will become more blurry as the value is decreased, and at a certain point these refractions will become so blurry that they prevent what is behind the object from being distinguished.

Refraction Glossiness default is set to 1.00, please refer to images below for impacts on different settings of Refraction Glossiness.

Images below set the Refraction IOR to 1.55, you can see the Glossiness changes gradually from 0.85. It changes rapidly between 0.80 and 0.75. When the setting for Refraction Glossiness remains the same, different Refraction IOR will change the Glossiness of the object.

Refraction Glossiness

<table>
<thead>
<tr>
<th>1.00</th>
<th>0.95</th>
<th>0.90</th>
<th>0.85</th>
<th>0.80</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="refraction_glossiness_1.00.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.95.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.90.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.85.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.80.jpg" alt="Image" /></td>
</tr>
<tr>
<td>0.75</td>
<td>0.70</td>
<td>0.65</td>
<td>0.60</td>
<td>0.55</td>
</tr>
<tr>
<td><img src="refraction_glossiness_0.75.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.70.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.65.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.60.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.55.jpg" alt="Image" /></td>
</tr>
<tr>
<td>0.50</td>
<td>0.45</td>
<td>0.40</td>
<td>0.35</td>
<td>0.30</td>
</tr>
<tr>
<td><img src="refraction_glossiness_0.50.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.45.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.40.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.35.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.30.jpg" alt="Image" /></td>
</tr>
<tr>
<td>0.25</td>
<td>0.20</td>
<td>0.15</td>
<td>0.10</td>
<td>0.05</td>
</tr>
<tr>
<td><img src="refraction_glossiness_0.25.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.20.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.15.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.10.jpg" alt="Image" /></td>
<td><img src="refraction_glossiness_0.05.jpg" alt="Image" /></td>
</tr>
</tbody>
</table>

Just like the intensity of the Fog Multiplier affects its transparency, the Refraction Glossiness in thicker objects becomes more obvious.

Refraction Glossiness 1.0  Refraction Glossiness 0.6  Refraction Glossiness 0.6 Gradient Map

V-Ray for Rhino 41
Image below shows the influence of Refraction Glossiness material to objects behind it. Objects further away become very blurry.

Images below show the difference with and without the Affect Shadows checked.

**Shadows of refractive materials**

There is an Affect Shadow option to the right hand bottom corner of the Refraction dialog box, default is unchecked. When checked, the color of the transparent object will affect its shadow and it’s not black anymore. The shadow also becomes more depth as well.

*It is recommended to always have Affect Shadows checked, as it produces a more realistic effect*
Double-sided material

Under Options of each material, you will find this Double-sided selection. Default setting is checked. This option is particularly important for transparent material. When this option is unchecked, light entering the inside surfaces will not be rendered and show up black. The reason to have this option is that sometimes you may want to uncheck this option when render object with translucent material (see next page) in order to get the right texture.

Unless you want to create some special effects, please have this option checked.

The double sided option will not have any effect on the shadows of the objects.

Translucent material

We’ve talked about changing the Diffuse color to get the degree of transparency we want to create before. White means 100% transparent, black means 100% opaque. You can create translucent materials with colors anywhere between white and black. But now we want to introduce a different translucent material. It is related to special light absorption materials.

Open file: Translucency.3dm and render it, you will get image like below on the left. You will see that colors where partitions meet the outside box and at the base of the box are darker. This is because the thickness of the object changes and the light travel distance changes also. So the degree of light absorption varies. To create this kind of material, you have to check the Translucency option under the Refraction. Image on the right is the rendered result for Layer 02.
Check the Translucent box under Translucency first. Thickness is for control of light pass through the object, the unit for this is unclear. Keep these three settings as default. Other items required to change include:

1. Double-Sided must be unchecked so the light can get through to the inside of the object. This setting is extremely important.
2. Change the IOR to 1.
3. Decrease the Refraction Glossiness to a value below 1.
4. Do not use white color for the Transparency because that will turn the object to completely transparent and become dark after rendered due to absorb too much light. Do not use black color, either. That will not allow light get through the object at all. Pick a color anywhere between Val 80~150 will give you the best result.

Many rendering engines use Sub-Surface Scattering (SSS) to create this kind of material. This material is good for creating things like: wax, skin, milk, cheese, plastic and jade which all have a little translucency in it.

Translucency is created by absorbing light to the object’s surface so the color of the object will show up a little darker than its original color. If you still think that it's too dark even though the original color is set to the highest Val 255, the best way to fix it is increasing the intensity of your light in the scene.

Below are some examples.
Emissive Materials

Open file: Cups-Emissive.3dm and we are going to show you how to create a self-illuminated material. Select the green cup on the right. Under Properties>Material, click Edit to open the Material editor dialog box.

Add Emissive Layer

1. Click on the + next to the Cup_Green to pull down the layers. Right click on Emissive Layers and select Add new layer. You will see the new Emissive layer added to the right side.

Open the Emissive menu. Default set the color to white, intensity to 1 and Transparency color to black. Click on Material Preview and you will see a completely white material ball. Render it and you will get the image like the one on the right.

Self-illuminated material can make the object become a lightsource itself. It does not limit to a certain shape like a regular light type does. Every part of the object can be illuminated and used as a lightsource.

Self-illuminated material is perfect to create objects like: light ball, light tube, light shade, stylish lighting, cold light and lit screen. However, emissive materials should not be used as the primary lighting for a scene.

If you are using a physical camera in your scene, you may notice that your light emitting materials render black or darker than expected. This is because the physical camera reacts differently to light than a regular camera does. Because of this you may have to make your light emitting materials significantly brighter in order to be rendered by the physical camera.
**Adjust the Intensity**
Default set the Intensity to 1. Below images are rendered with Intensity of 3 (left) and 5 (right).

**Adjust the color**
Default set the color to white. Click on the color box to change to a different color. Notice that if the setting of the Intensity is too high, the color of the object itself will become close to white. Only the light come out from this self-illuminated object will carry the correct color. So we recommend you not to use this as a normal lightsource. Just make it as a decorative object in the scene.

Please refer to below image chart for results of various Emissive Intensities. By controlling the degree of Transparency under the Emissive Color, you can still keep the diffuse color of the object. For example, when the Intensity is higher than 2, the diffuse color is washed out and become white.

To avoid the self-illuminated object become white, please also refer to the Color Mapping

<table>
<thead>
<tr>
<th>Emissive Color</th>
<th>Diffuse Color</th>
<th>Diffuse Transparency</th>
</tr>
</thead>
<tbody>
<tr>
<td>R200, G161, B82</td>
<td>R155, G155, B155</td>
<td>R0, G0, B0</td>
</tr>
<tr>
<td>Emissive Transparency R100, G100, B100</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intensity</th>
<th>0.0</th>
<th>0.1</th>
<th>0.2</th>
<th>0.3</th>
<th>0.4</th>
<th>0.5</th>
<th>0.6</th>
<th>0.7</th>
<th>0.8</th>
<th>0.9</th>
<th>1.0</th>
<th>2.0</th>
<th>3.0</th>
<th>5.0</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1.jpg" alt="Image" /></td>
<td><img src="image2.jpg" alt="Image" /></td>
<td><img src="image3.jpg" alt="Image" /></td>
<td><img src="image4.jpg" alt="Image" /></td>
<td><img src="image5.jpg" alt="Image" /></td>
<td><img src="image6.jpg" alt="Image" /></td>
<td><img src="image7.jpg" alt="Image" /></td>
<td><img src="image8.jpg" alt="Image" /></td>
<td><img src="image9.jpg" alt="Image" /></td>
<td><img src="image10.jpg" alt="Image" /></td>
<td><img src="image11.jpg" alt="Image" /></td>
<td><img src="image12.jpg" alt="Image" /></td>
<td><img src="image13.jpg" alt="Image" /></td>
<td><img src="image14.jpg" alt="Image" /></td>
<td><img src="image15.jpg" alt="Image" /></td>
</tr>
</tbody>
</table>

V-Ray for Rhino 46
**Emissive Textures**

Except using colors as light source for the self-illuminated materials, you can also use texture map directly as light source.

1. Click on the “m” to the right of the Color under Emissive control panel.
2. The Texture Editor will then open up. Select Bitmap from Type's pull down menu and you will see the control panel show up to the right.

3. Under Bitmap, click on the “m” to the right of the file and pick a bitmap to use as the light source.

4. After the bitmap is selected, the “m” now becomes “M”. Click on the Update button to preview the bitmap. Click on Apply and you can use this bitmap as the light source.

5. Click on Update Preview and you will see the Bitmap is now on the material ball. Render it and you will get the result as the image on the right.
The darker environment lighting will not affect the Bitmap setting for self-illuminated material (ipod image). The Bitmap will still render as its own setting for brightness. Use the same way to create cold light effect. Also showed below are two other examples.

Click on the “M” and go back to the Texture Editor window. Please pay special attention to below options as these options are often used for controlling the Bitmap texture map.

Multiplier: Controls the intensity of the Bitmap. Default set to 1. Increase this number will intensify the color tone, brightness and color contrast. Preview will not show much of difference if the value is too small.

Blur under Bitmap: Control the blurriness of the Bitmap. Default set to 0.15. Set to 0 will not have any blur effect to the Bitmap.

Override under Bitmap: Adjust the Gamma value of the Bitmap. Increase the value will make the Bitmap brighter. This parameter is also important for linear workflow.

Tile: Repeat the Bitmap texture on the object. Default set to selected. When uncheck the Tile, you will see only one Bitmap texture on the object.

UVW Repeat: Controls how many times a map is repeated within a given space (either within the surface, or within mappings).

UVW Rotation: Adjust the degree of rotation of the Bitmap.

The darker environment lighting will not affect the Bitmap setting for self-illuminated material (ipod image). The Bitmap will still render as its own setting for brightness. Use the same way to create cold light effect. Also showed below are two other examples.
Texture Mapping

For most of the time we can't just use reflection and refraction to create a material for an object. For example: stone, wood, painting, package, sticky back paper and textile. We must use some texture maps to create these materials. Below are some examples of using texture map for rendering.

![Teapot Matte](image1.jpg)

Open file: **Teapot Matte.3dm**. Render the scene directly after opened and you will get the result as left image with only reflection material applied to it. Image to the right is the result of applying brushed metal texture map. You can see clear difference between these two images.

01. **Click on the teapot. Under** Properties>Material, click on Edit to open the Material Editor. Pull down the Diffuse menu from the right and click on the “m” next to the Color to open the Texture Editor.

02. **Select Bitmap from Type's pull down menu.**
03. Click on the “m” to the right of File under Bitmap to select a Bitmap file.

04. Click Update to preview the texture map.

05. Render it. Since we didn’t assign the mapping for the texture map, it will then follow the object’s UV setting to render.

06. Use Mapping to adjust texture map direction. Select the teapot first, switch to Mapping dialog under Properties.

07. Make sure the Show advanced UI is checked.

08. Click on Add to create a new channel.
09. Pull down the projection menu and change it from surface to planar.

[Image: Properties window showing mapping settings]

Render and you will get an image like the one below. Due to the Planar projection projects Bitmap from top down, the texture map is not yet showing the correct direction. Rotate the mapping widget to change the direction of projection.

[Image: 3D model with mapping widget rotated 90 degrees]

10. Click on Show Mapping to display the mapping widget in the window.

[Image: Right-click on empty space to rotate the mapping widget]

11. Under Rotation, make the x value -90, then left click on empty place. This will rotate the mapping widget 90 degrees off the x direction and projects the Bitmap from front to back.

[Image: Right-click on empty space to rotate the mapping widget]

Image on the left shows the mapping widget rotated 90 degrees; on the right is the rendered result.

[Image: Rendered image of the 3D model]
Projection types and adjustment
The different types of projection are Surface, Planar, Box, Spherical, Cylindrical and Capped cylindrical. Rhino sets the default to Surface if there is no other projection assigned to the object and render the object according to its UV directions.

When change to a different projection, the default size of mapping widget is set to the perimeter of the object.

Show Mapping is to display the mapping widget in the scene. Within the working window, the mapping widget can be moved, rotated and scaled.

An object can have multiple projections at the same time, each within a different channel. Use Add to create a new channel. Under Material Editor>Texture Editor, you can select the channel for each texture to work with. Use Edit to number the channel. Use Delete to delete current channel. Other adjusting options include Position, Rotation, Size, UVW offset, UVW Rotation and UVW repeat.

Type of projection, size and position of Mapping Widget, project direction will all affect the Bitmap on the object. Of course, those will also affect the final render result.

Below are examples using teapot to show different UI setting. Use correspondent UI for different object. Spend some times to find exact what you want to get the ideal render result.

Click on F10 to show the control point for the Mapping Widget. Move those points to adjust the size of Mapping Widget.
Bump Maps

Adding a Bump Map
Although we can use Bitmap for most materials of the objects, but some textures like wall surface, tile, wood, oil painting, leather and water, which all have the uneven surface, must use Bump map in order to create them.

1. Click on the teapot and open the Material Editor to edit the Bump map to the teapot. Under the Maps from the right side of the Material Editor, check the Bump and click on the "m" to open the Texture Editor.

2. Same as before, select Bitmap under the Type pull down menu.

3. Click on the "m" to the right of Bitmap, select the same bushed metal material as used in Diffuse for the teapot.

4. After importing the map, if the Bump map is the same as the Diffuse map, make sure the U, V Repeat under UVW Transform have the same value. For example, if Bump map is using U: 2 and V: 2, the Diffuse map should be the same. Otherwise, these two maps will not align correctly. Also, start the Multiplier on the left side with smaller value like 0.1. If set the Value too high will result an unnatural look of material.
Bump map is created using the grayscale of the Bitmap to set the high and low texture. The bright part of the Bitmap is considered as high and the dark is low. The Bump map is seen more clearly at the part where the object reflects the most of the light. Using Bump map texture to create bumped texture is only a visual effect, not the true surface of the object. Look at the edge of the object and you will still see the smooth surface.

Image on the left is result of using only brushed metal Bitmap. The surface of the teapot looks very smooth. Image on the right is rendered with Bump map added to the teapot and its handle. Obviously you can see the Bump texture within the brushed metal and handle.

And also, earlier we talked about using Reflection>Glossiness to adjust reflecting material's glossiness and create frosted look of the object. If add a little bit of Bump map to it now will make the object looks even better.

Image on the left is using only Glossiness from Reflection setting. Image on the right has Bump map added to it.

Below are some examples of textures created with Bump map.

Bump map is created using the grayscale of the Bitmap to set the high and low texture. The bright part of the Bitmap is considered as high part and the dark is low. The Bump map is seen more clearly at the part where the object reflects the most of the light. Using Bump map texture to create bumped texture is only a visual effect, not the true surface of the object. Look at the edge of the object and you will still see the smooth surface.
**Alpha Contribution**

With alpha contribution you have the capability to obtain the alpha channel of each material on the scene. This works by using the scale between 1 and 0, this means 1 no alpha (all White) and 0 full alpha.

**Adding Alpha contribution**
Open the material editor and click on the material option option tab, then change the number of alpha contribution for each material you want an alpha channel.

**Working with a Alpha Contribution**
You can find the alpha channel on the V-Ray frame buffer.

Here are examples of different Alpha Contribution settings.

<table>
<thead>
<tr>
<th>RGB channel</th>
<th>Alpha Contribution 0</th>
<th>Alpha Contribution 0.5</th>
</tr>
</thead>
</table>

V-Ray for Rhino55
Displacement allows you to recreate the texture of a surface by using a black and white image to describe the varying height of the surface. This is very similar to how bump mapping works, but each method does this in a different way. Bump mapping simply shifts the surface according to the image applied to it, without actually changing the geometric structure of the surface. This causes bump mapping to be somewhat limited in its capabilities of representing those surfaces. Displacement on the other hand actually creates the geometry that is described by the image. This is done by subdividing a given piece of geometry and adjusting the individual heights of all of the faces based on the image that it is describing. The result is a surface that produces a much more accurate and realistic result.

**Adding Displacement**

Using displacement is very similar to using bump mapping. In fact, you can probably use your current bump maps as displacement maps. In the Maps rollout of the material options there will be an option for Displacement. Enable displacement by clicking the check box on the left, and the proceed to click on the “m” to add a displacement map. Although textures are used for displacement maps in most situations it is possible to add a displacement map via the procedural mapping.

Once either a texture or procedural mapping is added there is one last thing that you will have to pay attention to while still in the texture editor, and that is the multiplier. The multiplier is what is actually going to determine the final size of the displacement this will reference the Amount value in the Displacement rollout.

**Displacement Parameters**

In the V-Ray for Rhino Options there is a rollout which contains the parameters for displacement. It is important to note that these are global controls for all of the displacement throughout the scene. Currently there is no individual controls on a per object or material level. This means that you must be aware of the settings within this rollout when adjusting an individual material’s displacement.

The Amount value may possibly be the most important value within the rollout, as this value will determine the scale of all displacement. The Amount value is the number of scene units of an object with the texture multiplier set to 1. This means that one could adjust the affect of displacement through either the Amount value or the texture multiplier, but because the Amount value affects all displacement, it is recommended that it be left constant and the texture multiplier be used to adjust the displacement of an individual material.

Both the Maximum Subdivisions and the Edge Length will affect the quality and speed of the displaced mesh. Maximum Subdivisions will control the amount of subdivided triangles that are allowed to be created from a single triangle of the original mesh. In general, it is better to have a slightly denser mesh and lower maximum subdivision rather than a simpler mesh and a higher maximum subdivision. Depending on density of the render mesh created by Rhino, the max subdivisions may not necessarily come into play. The edge length will determine the maximum length of a single triangle. By default this value is expressed in pixels, but if you disable View-Dependant then the edge length value will reference your scene units. Smaller values will lead to a higher quality, while larger values will decrease the quality.
**Adjusting Displacement**

Depending on how you set up your global displacement values you can set up your texture multipliers in one of two ways. The first way, which is the simplest, is to keep the Amount value in the displacement options at 1 and to adjust the texture intensity as an expression of scene units. The plane on the left has a texture multiplier of .5, which in this case leads to a maximum displacement of .5 units. The plane on the left has a multiplier and maximum displacement of 2.

The second way to set up displacement by making the maximum displacement the Amount Value in the V-Ray options and setting the texture multipliers as a percentage of that maximum value. In the case of the two planes to the right the Amount value is two. The plane on the left has a texture multiplier of .25 and the plane on the left has a multiplier of 1. You will notice that the rendered image is the same in both cases. That is because it does not matter the method that is chose, only that the multipliers are inline with the desired effect.

The image on the left is an example of the different quality settings for displacement. The plane on the left has an Edge Length of 24 pixels and a Maximum Subdivision of 6. The plane on the right has an Edge Length of 2 pixels and a Maximum Subdivision of 512.

Here is a comparison of bump mapping (left) and displacement (right). Both the maps and intensities are the same. As you can see the bump map is limited in its ability to create the depth that is capable with displacement.
**Transparency Mapping**

**What’s Transparency Mapping?**

Transparency mapping is another method using Bitmap to create materials. The difference is that this is using alpha channel to get rid of unwanted part of the Bitmap, saving only the part covered by alpha channel. This is called a mask.

This is used mostly for creating product logos, stickers and numbers. Many users try to avoid using transparency mapping and model the actual object in the scene. Although you can ignore material settings by creating the actual model of objects, that will increase both the number of objects in the scene and the file size. The more objects you get, the longer the rendering time you would need.

You will get the result as left image if you apply the texture map directly without transparency map. The black background of the texture map is blocking part of the cup. The image on the right is rendered with transparency map.

Open `Cup_Decals.3dm`. Here is the object and the transparency map that we will use to create our label.

You will get the result as left image if you apply the texture map directly without transparency map. The black background of the texture map is blocking part of the cup. The image on the right is rendered with transparency map.
1. Click on the cup and open its Material Editor. Open Cup_Red; right click on Diffuse Layers to add a new layer and you will have the dialog window as image on the right. A Diffuse1 control panel is added under the Diffuse.

2. Click on the “m” at the right of Transparency under Diffuse to enter the Texture Editor. Load the Bitmap for Transparency texture map. Make sure you uncheck the Tile first to avoid repeating this Bitmap on the object.

   Use Photoshop, PhotoImpact and similar image editing software to create black and white image and save as .bmp, .jpg or .png which are the formats accepted by V-Ray.

3. Use Diffuse1 color to edit the color for this Transparency map. Click on the “m” at the right of Color to add more texture to this map if needed.

   Render it and will get image like below. The Transparency map is covering the entire cup. That’s because there is no mapping applied to this cup yet.
4. Under Properties>Mapping, add a new channel, change the projection type to Planar, and adjust the mapping widget’s size and position as image showed below. If the Tile remains checked, it will render as the image on the right.

How Transparency Mapping works
The diagram below depicts transparency mapping. The idea is using a grayscale image as mask, black area will not be penetrated and only white area will let light through, other gray area will then become translucent.

The white area get the color assigned in Diffuse1 and end up showing on the surface of the object after rendered.

For the cup example above, after assign a mask to the Transparency, the red color of the cup is affected by the white area of the mask and no longer showing red. The second layer of the Diffuse1 color at the diagram below is used to cover the white area of the first layer.

Another method for creating the same result
Totally opposite from the method above, set the Diffuse to white, Transparency as mask, but switch the black and white area, and let the Diffuse1 color show up at the upper layer. Assign the Diffuse1 color to red and will get the same result as above after rendered.

V-Ray for Rhino60
Other Uses for transparency mapping
There are many ways to use transparency map, not just used only for text mask as example before. Here are some more examples often used to create a texture map. First is using a gradient Bitmap as the Diffuse Transparency mask; let the yellow color of Diffuse1 show up through the white area at the cup and create two gradient colors on the cup as image on the right. This is the better way then using a gradient Bitmap directly as the Diffuse texture because of its flexibility of changing the colors. You will have to make another Bitmap of different colors combination if the color need to be changed.

The second example is using other grayscale Bitmap as the transparency mask. Although it is not a gradient image, but they work exact the same. A rendered image on the right.

The third example is adding another Diffuse2 layer, and assigns a 0 degree and a 180 degree gradient Bitmaps to Diffuse and Diffuse1 in Transparency. Give the Diffuse2 a third color to create this three-color gradient rendering effect for the cup. A rendered image is on the right.
The forth example is to use gradient color in refractive material. Similar to previous examples, use a gradient grayscale Bitmap as the Diffuse Transparency mask. Add a Refraction layer to create the half transparent and half opaque effect.

The fifth Example is the same as the third example, with the difference being a refraction layer, and changing the transparency color of Diffuse2 to white. This will make the white area at the middle become transparent. A rendered image is on the right.

The example above can not have the transparent quality at the top and bottom of the cup because of the black color in the grayscale gradient Bitmap. The last example below is to use a pre-made gradient Bitmap as the Refraction Transparency map. Set the Diffuse Transparency to a usual white, and then assign the Bitmap to Refraction under Refraction control panel, and you will get the same result as the image shown on the right.
V-Ray Two-Sided Material

The V-Ray Two-Sided Material, or Vray2SidedMat as it appears in V-Ray for Rhino, is a material that allows easy creation of very thin translucent objects such as paper, lamp shades, or curtains. It works with the very simple controls so it's much easier to control the result than using a translucent material, and it renders significantly faster as well. Due to the nature of this material it is actually best to have single surfaces rather than a solid, as you would need for any refractive material.

Adding a V-Ray Two-Sided Material
First we will need to add a Two sided material. Open the material editor and right-click on Scene materials and go to Add Material. This will in turn bring up another menu with several different material formats. Click on Vray2SdMat which is in the middle.

Working with V-Ray Two-Sided Material
Now that the Two-Sided Material has been added, we will expand the material and notice that this looks much different then the standard V-Ray material. This is because the Two sided material works with predefined materials. There are two slots, one for the front material and one for the back material, as well as color which will determine the ratio between the front and the back material.

You cannot actually create a new material once inside the Two-Sided material as it only works with predefined materials. When you click on the button for the front material, a dialog box will open up asking you to choose which material you would like to have be the front material. You must also define a material a material for both sides, but you can define the same material for both sides. If you don’t specify a material for either the front or the back, then Vray will assume that there is no material.

The color is how V-Ray determines the ratio of front material to back material. The color works with grayscale values, and produces the best results between 35-220.

If you would like to recognize which faces are the front and which are the back, then you can configure backfaces to be a different color when they appear in the viewport. This can be configured by typing AdvancedDisplay into the command line and configuring the backface color in the desired display type.
The V-Ray for Sketch-Up Two-Sided Material, or VraySkp2SidedMat as it appears in V-Ray for Rhino, is simply a material that allows for the front faces of a material to have a separate material than the back faces. It can be very useful when creating very quick conceptual renders when trying to convey ideas with minimal modeling. This tool developed out of Sketch-Up users’ desire to create a V-Ray material that would act with different materials as the standard Sketch-Up material does.

Adding a V-Ray for Sketch-Up Two-Sided Material
First we will need to add the Sketch-Up Two sided material. Open the material editor and right-click on Scene materials and go to Add Material. This will in turn bring up another menu with several different material formats. Click on VraySkp2SdMat which is the last option.

Working with V-Ray for Sketch-Up Two-Sided Material
The Sketch-Up Two-Sided material looks very similar to the V-Ray Two-Sided material. It has two slots; one for the front material, and another for the back material. As with the V-Ray Two-Sided material the materials cannot be created from within the Two-Sided material, but must be already created in order to be added to either the front or the back material. Although it is possible to utilize much of the features of the standard V-Ray material within the Sketch-Up Two-Sided material, it is not recommended to use any refraction layers within materials used for the Two-Sided material. Unlike the V-Ray Two-Sided Material, which needs a material for each side, the Sketch-Up Two-Sided Material will work just fine without a material defined for each side. For whichever side does not have a material assigned, that side will not be rendered. This can be very useful for architectural visualization, and can be used to look inside rooms with the appearance of the wall still affecting the illumination of the enclosed environment.
V-Ray Angular Blend Material

You can create Angular Blend material in V-Ray for Rhino, giving you the option to create a blend between two material. To determine the amount of blend between two material, it uses the angle between the view direction and the surface normal. It is very useful to create materials such as velvet material.

Adding a V-Ray Angular Blend Material
Open the material editor and right-click on Scene material go to Add Material, then click on Add Vray AngleBlendMtI.

Working with a V-Ray Angular Blend Material
The Angular material work alike Two-Side material, need two predefined material. Put your dark material in the fist slot and your bright material in the second slot. The Star and stop Angle slot control the amount of blend between those materials.

Samples of Angular Blend Material

V-Ray for Rhino65
Environment Lighting

Lighting plays the key role in the rendering process. You simply can't get a good rendering result without a good lighting environment.

Same as the real space lighting, light sources are divided into direct and indirect lighting. Direct lighting is using the light command to create Rectangular Light, Omni Light, Spot Light and Parallel Light and use directly on the object. Indirect lighting refers to any lighting which is from bouncing light, or an environment.

Let's do a test

Open file: Cup Illumination-01.3dm, there is no any light in the scene. Light source is from Environment light.

1. So far the cup and ground are using the same Val230 off white color. Render it with GI default setting to 1 and get the result as image shown on the right.

![Image 1](image1.png)

2. Increase the GI value to 2 without changing the color, the result is shown on the right.

![Image 2](image2.png)

3. Do not change the GI value and change the Brightness to Val127 under the Texture Editor. Render it again and the result is very close to the first image on the top.

![Image 3](image3.png)

The reason for doing this test is to let users understand the importance between lighting and material. Should the lighting be adjusted to accommodate material or should material be adjusted to accommodate lighting?

V-Ray for Rhino66
It is clear from the previous example that the lighting must be adjusted to accommodate materials. With the second image from the previous test if we created another material and inserted into the scene, it would not render how we created it.

Here’s another example. Let’s take the shirt that you’re wearing right now. What color is it? If you walked into a closet with no light, what would the color of your shirt be? The answer is that the color of your shirt would be the same, but it would appear different based on the lighting environment. This is why you should adjust your lighting to achieve the desired affect, as opposed to changing the materials.

With an incorrect lighting environment, such as the second part of the example on the previous page, it will be very hard to predict how your scene will react. When adding a new material, it will not look how it did when you created it, thus making it harder to achieve the original intended appearance for the material. Incorrect lighting also has an adverse affect on other aspects of your rendering and may affect shadows, reflections, and even make your rendering take longer than it should. Now you see why having a proper lighting solution is very important.

**Interior or Exterior?**
When facing the task of illumination, separate it into interior illumination and exterior illumination. Here exterior means open space. For example, place an object on the ground without any walls around it to block the light. It’s easier to adjust illumination for open space. Interior means light source is blocked by wall or other similar objects in the scene; an enclose space in which the environment light will not have the direct effect to the object. Or maybe some openings on the wall or windows allow part of environment light comes through them. Interior lighting is generally more complex than exterior lighting.

Image on the left shows open space illumination and image on the left shows the semi-open space illumination.

Image on the left shows the same semi-open space but add one more opening to the wall. The brightness increased due to second opening added to the wall. Image on the right shows different locations for openings also affect the brightness of the scene.
Techniques for adjusting illumination

Before rendering a scene, try to finish all the modeling as this greatly simplifies the task of adjusting the illumination. The number of objects, object location, material type, color and even size will all affect the illumination in some way.

When beginning to create the lighting solution it is important to have a solid base in which to begin evaluating how you will need to light your scene, as well as how it will react to lighting. With Vray this task is very easy because of how the environment light works. Basically, with your environment color set to white \((255,255,255)\) and the intensity set to 1, you should get a neutral lighting of your scene. This is useful in that it will allow you to properly assess the appearance of your materials, as well see if there are any areas of your scene which will naturally receive more or less light from the environment.

Now lets see this in action. Open file Cup-Illumination-01.3dm again. This is an easy open space example, there is no light added to the scene, and the Environment color and intensity are currently set to Val 255 and 1 respectively.

Using a white floor color is important as it will show the most amount of light that will effect the scene. This is because white allows the most amount of light energy to be retained after it bounces off a surface. With the white floor, we know that if we change its material to something that is darker, than we can expect a little less bounced light in our scene. In an exterior scene like this one the effect is minimal, but when creating an interior illumination solution this is an important thing to know.

1. Assign the Val 230 color to floor, R191 G19 B19 red color to cup first, render it and result as below.

![Image 1](image1.png)

2. Re-assign the R255 G100 B100 red color to the cup and render; you will get the result as below.

![Image 2](image2.png)

From the two images above we can see the colors for the floor and cup are rendered very close to actual colors, which means the Environment lighting is set to correct intensity and brightness for creating good illumination. Otherwise, if the intensity is too strong, it will make the floor and cup appear brighter than the values that we set when we made the material.

Now that we have a good render we can begin the task of adding more lighting into the scene. Depending on what you are trying to create this may only required one additional light (the sun perhaps) or many lights. The important thing to remember is that the lighting must be balanced. Since we already have a scene which would become overly bright, or burned as it is sometimes called, if any additional light is added there must be a compromise between the different lights. In most cases this will mean that the environment intensity will be decreased, but the ratio between environment lights and other lights is something that you must determine. Try out different options; one where the environment light is stronger than other lights, and another where other lights are stronger than the environment.
**HDR Environment light**

Instead of using a color for an Environment light source, V-Ray also supports HDR images to use as Environment light source. Open file Cups-HDR.3dm.

1. Open V-Ray for Rhino's Render Options, open Environment menu and click on the “m” at the right of GI to enter the Texture Editor.

2. Choose Bitmap from Type, click on “m” beside File and import an .hdr file.

3. Because the textures is being applied to the environment and not an object make sure you check the Environment under UVW after the file is imported.

Render it and will get the image on the right. You will see a big difference between this image and the image that used only color for Environment light source. This is because the HDR is providing the illumination for the scene based on the colors and intensities of the image.

4. If you want the object reflect the HDR image Environment as well, you can assign the same HDR image to the Environment Background, and make sure the UVW is set to Environment. After the Background HDR is added, the result is as image on the right.
To compare, below are three images rendered with different HDR images as the Environment light sources. You can see the light and color change dramatically according to each HDR image.

Due to the fact that HDR images are usually provided by others, the lighting environment may not produce the desired effect. It may take sometime to adjust the intensity.

Although HDR image has produces better results than a normal image, HDRs still lack the true brightness of a natural environment. So normally it's used only for Environment light source, and usually some additional light is added.
**Bitmap Environment light source**

If the user does not have HDR image, a regular Bitmap can be also used as Environment light source. Although a normal Bitmap doesn't have the same ability to create as dynamic an environment, normal images are very easy to get. As long as you pick the right Bitmap and control the Intensity well, it can still be a very good Environment light source.

The three images on the right are rendered with a different Bitmap. If you compare them to image rendered with HDR images, it is not as easy to determine the direction of the light and the shadows are not very clear.
Environment light source for semi-open space

We used open space to discuss Environment light source for last example. Now it time to use semi-open interior space for this example to see differences between interior and exterior illumination.

Open file: `GI Environment-01.3dm`. In the scene is a enclosed cube with an open on the right. There are some objects placed on the wall next to the opening wall and there is no light in the box. All objects used Val190 gray color, current GI Intensity is 2, color is light blue. Render it and you will get the almost black image on the right. The result is due to no light in the scene and only a small opening allows the Environment light come in.

Increase the GI Intensity to 4 and render it again. The result is as below, a little bit brighter this time.

Increase the GI to 8 and render again. The result is closer to reasonable illumination.

This example shows that Environment light in semi-open spaces usually doesn’t lead to a proper solution the first time.

When beginning to set up the illumination for interior space, a first step should be to check how many openings in the scene allow environment light to come in. This includes transparent objects like windows or doors. It is also important to know how many lights are intended to be in the final scene, as well as what time of day the rendering is meant to depict. These are all very helpful for setting the Environment light correctly.
Even if the Environment lighting is set to the desired level for the final scene, you will still wind up having to adjust it based on the materials and other lights that will be added to the scene. Very often the camera got moved during this process and the quality and brightness are not what you were expecting. Even though the interior lighting is under control, once the camera is pulled out from the box, you will get the bright white rendered result as the image on the left.

It will still be necessary to add light in the room, adjust the brightness and render as image on the right.
Choosing different Render Engines

In order to calculate indirect light within V-Ray a render engine must be specified to compute those calculations. Each engine has its own method of calculation and each with its own advantages and disadvantages.

V-Ray is uses two render engines to calculate the final rendered image. Open Indirect Illumination control panel under Options. There are Primary Engine and Secondary Engine options in the panel below.

There are four options for Primary Engine: Irradiance Map, Photon Map, Deterministic Monte-Carlo and Light Cache. Default is set to Irradiance Map.

There are three options for Secondary Engine: Photon Map, Deterministic Monte-Carlo and Light Cache. Default is set to Deterministic Monte-Carlo or you can select None to not use this Engine.

When switching between different engines, the control panels will also change according to the assigned engine.

Classification of Light bounces

Direct light- This is the light which is calculated directly from a light source. If GI was not enabled, or if there wasn't any engine selected of either primary or secondary bounces, these rendered image would be the result of only the primary bounces. It is not necessary to specify an engine for these calculations as these are done through standard raytracing. Environment light is not considered a form of direct light.

Primary bounces- this the light which is the first bounce after the direct light hits a surface. Usually these bounces have the greatest effect on the scene in terms of the indirect lighting, as these bounces retain a significant portion of light energy. Environment light is calculated as a primary bounce.

Secondary bounces- this is all of the light which bounces around the scene after the primary bounce. As light bounces around a scene, its intensity, and therefore its affect on the final illumination, becomes less and less. Because of this secondary bounces can all be calculated through a single method. With exterior scenes these bounces have a relatively insignificant effect on the final result, however with interior scenes the bounces can become as important as primary bounces.

It is important to remember these classifications when evaluating an image’s quality, and adjusting settings to either achieve better or faster results.
Primary Engine: Irradiance Map

It can only be used for primary bounces. Open file Cups-Irradiance Map.3dm and open the Irradiance Map control panel under Options. There is a very important setting option here related to image quality: Min Rate and Max Rate.

Default for Min Rate and Max Rate are -3 and 0. In this file they are currently -8 and -7. Render it and you will get image as below. Notice that the calculation speed is very fast, but the shadow and illumination quality are low. The image include splotchiness and artifacts as well.

Min Rate: the control of minimum sample for each pixel. 0 value means 1 pixel as 1 sample. Value of -1 means 2 pixels as 1 sample. Value of -2 means 4 pixels as 1 sample and so on. Smaller value means fewer amount of samples been taking from the object, so the render qualities of shadow, reflection and refraction are not very good. Opposite way will result in better quality but longer render time.

Max Rate: To control the maximum sample for each pixel. 0= 1 pixel uses 1 sample. 1= 1 pixel uses 4 samples. 2= 1 pixel uses 8 samples and so on. Smaller value means fewer total samples used to calculate the light. Opposite will result in better quality but longer render time.

Default setting of -3 and 0 represent four passes of render job. From -3, -2, -1 to 0. So you can see the Prepass 1 of 4 to Prepass 4 of 4 from the render process dialog box.

According to definitions above for Min Rate and Max Rate, it doesn’t mean that -8 and -5 setting will have the same result of -3 and 0, even though each has the same.

Users can have a low set of values for Min and Max Rate to render faster previews while creating the lighting and material setting in the scene. For example: -6 and -5 or -4 to -3. Although the quality might not be good, it should be acceptable for previews. After all settings are correct, then render with higher value to get the best final quality image.

The Image on the left is showing Irradiance Map’s last prepass for a Min/Max Rate of -3/0. The image on the right is the final result.
The image on the left is showing the last prepass of -4 and -3. The image on the right is the final result.

The image on the left is showing last prepass of -3 and -2. The image on the right is the final result.

The image on the left is showing -3 to 0. Image on the right is showing -3 to 1. Although the one on the right has the better final result, but the difference is very little.
When working with complex images it may be necessary to do more than just adjust the Min and Max Rate. Subdivisions are the next means of quality control with Irradiance Map. Higher subdivisions will yield better quality. With Higher subdivisions it may also be necessary to add more samples. In the examples below both images have been calculated with the same Min/Max Rate, yet the Subdivisions have been increased from 50 to 100, and the samples have been increased from 20 to 40. You can see in the arrangement of the irradiance points (the little white dots) that the second image is much smoother.

When Min Rate and Max Rate are too low, "leaking light" happens even if the objects are joined together. See image on the left for example. This is due to lack of Samples when calculating the Prepass. Of course, this only happens when using Irradiance Map rendering engine.

The image on the left is rendered with Min Rate and Max Rate of -4 and -3. You can see light comes through the corner clearly. The image on the right increased the value to -3 and 0 and you can see a big improvement.
Primary Engine: Deterministic Monte-Carlo

Deterministic Monte-Carlo is the most accurate method of light calculation in V-Ray. It is most useful for scenes with a lot of small details. The downfall with this method is that takes significantly longer to render. There is also no prepass for this calculation as it is done as the image is rendered.

Image on the left is rendered with Irradiance Map. Image on the right is rendered with DMC. Although the one on the right looks slightly grainy, the colors are reproduced much more accurately with the DMC calculation.

DMC generally produces a slightly grainy result. One of the ways you can improve this is by using a different image sampler. Open the Image Sampler tab in Render options and change the Sampler from Adaptive Subdivision to Adaptive DMC. Although Adaptive Subdivision produces predictable and fast results, Adaptive DMC works very well when DMC is used for primary bounces. Now change the Max Subdivisions to a higher number (such as 50). This will help decrease the grain in the image.

With DMC it is much easier to set up a rendering as there are very few settings that will need to be adjusted. Artifacts such as light leaks and splotchiness will not be a factor in DMC renders.

It is recommended that DMC only be used for final, or high quality test images due to the amount of time required to complete the render. It is a good idea to use Irradiance Map or Light cache for test images, then switch to DMC for final images. Results similar to DMC can be obtained through Irradiance Maps, usually with less time than DMC, so it may not be completely necessary to switch to DMC for final images depending on the situation.
**Secondary Engine: Light Cache**

Light Cache is used for Secondary Engine to calculate light distribution in scenes. Its calculated in a way that is very similar to Photon Mapping. With Photon Mapping the calculation starts from the light source and collects light energy along way. Light Cache starts from the camera instead. Some advantages to using Light Cache are that it doesn’t have many settings to deal with and it renders quite fast.

The image on the left is rendered with combination of Irradiance Map and QMC and the image on the right is rendered with combination of Irradiance Map and Light Cache. The image on the right is slightly brighter. This is due to the fact that Light Cache calculates an infinite number of secondary bounces, where QMC only calculates a predetermined number of bounces. Although each of these bounces individually is insignificant, their added affect increases the brightness of the image.

Subdivs is the most important factor for Light Cache. Subdivs is used to decide how many light traced to use from Camera to calculate the light distribution. The actual number of traced is the square of the number of Subdivs. As default of 1000 for example, the actual number of traced rays will be 1,000,000.

When determining how many Subdivs will be sufficient for an image, the best way is to look at the progress window, monitor the appearance of the image in the frame buffer, and approximate the number of samples according to the progress and total number of samples. Say the Subdivs number is 1000 for example, when the Subdivs is half way through its calculation, the rendering window’s black dots are almost gone, that means you only need to set the number between 500–600 and you will get the correct render result. If the process is done but still have a lot of black dots in the window, that means more subdivs are needed to produce an accurate result. Image below is showing a Light Cache calculation which still has a large number of black spots.
Another important option with Light Cache is the Sample Size. This is used to determine the size of each sample. A smaller number will yield a more detail and a sharper image, where a larger number will lose some detail but have a smoother result.

With each of these images the primary and secondary bounces are calculated with Light Cache. The images on the left has a sample size of .02 and the images on the left has a size of .03. With both cases the top image is the result at the end of the Light Cache calculation and the bottom image is the rendered result.

It is important to note that Light Cache is not appropriate to be used for primary bounces, as it does not produce smooth results or good details. It is only being used as a primary bounce in this case to illustrate the difference in sample size.

**Scale in Light Cache**

In order to determine the size of each sample, Light Cache gives itself a scale to work with. The default setting for scale is Screen. This means that each sample is a percentage of the image. The default value is .02, or 2 percent. Which means that the size of each sample is approximately 2 percent of the total image. It is possible to use the scene units to determine the size of the samples. To do this change the scale to World, and now the sample size is in scene units. The advantage to using screen units over world units is that with screen units more samples will be added to objects which are in the foreground of the image. With world units many samples will be added to objects far away, while objects which are closer to the camera will receive fewer samples. Because of this issue it is recommended to keep the scale at the default value of screen.
Spotlight Point Light Directional Light Rectangular Light
color, multiplier and shadow on/off, each also has Subdivs for shadow quality control, Photon Map for render quality control, Caustic Subdivs control and Bias for shadow off set. The difference is only with Directional Light, Point Light and Spotlight which have the ability to adjust the radius of shadows.

Point Light and Spotlight are the ones need to control the Decay itself: Linear, Inverse and Inverse Square. The last two Decay dramatically. So when using Inverse or Inverse Square, you must increase the multiplier. That means Point Light and Spotlight are very much affected by the distance from an object, so it will take longer time to adjust these two lights.
The quality of Shadow
Unless the shadow is turned off, all objects will cast shadow under light.

The quality of shadow is control by Subdivs under lighting dialog box. Rectangular light for example, under Sampling>Subdivs, please change the default 8 accordingly to get desire shadow quality. The higher number will cost more time to render. When set it to 32, you can get the almost perfect shadow without any noise.

Image on the left is rendered with Subdivs set to 8; image on the right is set to 32.

Radius for Shadow edge
When using Point light, Spotlight and Direction light for light source, the shadow edge will be very sharp. To improve it, adjust the Radius under Shadow dialog box. Using Directional Light here for example, Image on the left is rendered with Radius set to 0. Image on the right is rendered with Radius increased to 0.05.
The Shadow Color

In order to change the shadow color, click the color picker under the shadow properties.
Adjusting the Camera

Rotate the camera
Click and hold on both Alt and Shift, then right click on the mouse to rotate the camera. This will make the image more dynamic.

Adjusting the lens
Right click on the Perspective window title and select the Viewport Properties from below. See image below, you can input desire lens length here. Smaller number for wide angle lens and larger number for telescope lens.

If you don't want the objects deformed too much, try to avoid using wide angle lens. A normal product can get the best perspective by using Rhino's default 50mm lens. Use a 22-35mm lens for interior shot.

The image on the left is perspective with 50 mm lens; The image on the right is 28 mm. Its angle looks much wider.

Please note that if the lens has very small number, the lens will make the object deform even greater.
Depth of Field

What’s Depth of Field?
Depth of field refers to the amount of an image which is in focus and the amount which becomes blurry. In photography it is impossible to have every part of an image in perfect focus. Because of this a photographer chooses what will be in focus and what will not. Within Vray this will correspond to the focal distance. The amount in which an object which out of focus depends on how far the are away from the focal distance of the camera as well as the size of the camera’s aperture. A small aperture will have a only a slight amount of blurriness for objects which are not within the focal distance. A large aperture will have a large amount of blurriness for objects outside the focal distance.

Open V-Ray for Rhino’s Render Options. Pull down Camera control menu and will see the big item of Depth of Field below. Default is set to off, check it if you want to have the depth of Field in the final rendering. Depending on the way your camera is set up you may want to check Override focal distance. With out this setting enabled V-Ray will use the focal distance of the camera.

How to find out the current setting of focus distance of the camera?
1. Open file Cups-Depth of Field.3dm, as show on the right, in perspective view, right click on Viewport Title and select Show Camera. See image below, the narrow point in the scene is the lens of the camera, the point on the opposite side is the Target.

2. Use Polyline tool to draw a straight line, open snap point mode, left click on the camera point and move the mouse over to Target point. Look at the distance window below and that's the number to use for the Override Focal Dist. In this case, 62.3724 is the number to use. Render it and you will get the rendering with Depth of Field effect.
And also, hit the Tab key when the cursor is locked to the Target point, and then move the mouse. You will find the direction from camera to Target point is locked. Move the cursor and the number for distance below will change accordingly. Move the cursor to desire focus location and memorize the number below. Use this number for the Override Focal Dist. and become the new focus distance. Hit the Tab key again to unlock the direction.

The image on the left is rendered without Depth of Field and the image on the right is rendered with its Aperture set to 1.0. The Depth of Field has already apparent in the image and the focus point is at the green cup.

**Size of Aperture**

There is Aperture located at the top of the control panel for Depth of Field under Camera. V-Ray doesn't use the same number unit of F1.4 F2.0 F11 as the normal camera does to control the amount of light comes into the camera. It uses the system unit for its size. Smaller numbers have less effect on Depth of Field. Larger numbers will make the object very blurry and takes a longer time to render, especially when calculating the edge of object for Depth of Field effect. So we recommend you start with a smaller number and move your way up if you need stronger effect.

**Change Focal Distance**

Go back to Camera's control panel, keep the Aperture as 1.0, then input 47 for the Override Focal Dist. and make it closer to the red cup's opening edge. Render it and you will get the image on the left, when the green and red cups become blurry. The image on the right is rendered with Override Focal Dist. changed to 72, approximately at the front edge of the red cup. So now the yellow and green cups become blurry.
The glass cups are products of Nachtmann from Germany.
Physical Camera

The Physical Camera feature allows the camera’s reaction to light to mimic that of a camera in the real world. This means a much more natural reaction to light as well as an added dimension of control over the lighting of your scene. There are also added ways to adjust your rendered result.

Type of Camera
In V-Ray’s physical camera parameters you will see that there are three options within the types of cameras. The first is a still camera, and the other two, cinematic and video, are for use with animations. We will only be concerned with the still camera, as the others are used to do camera matching with existing footage. The still camera may still be used with animations, and produces great results.

Exposure
In the real world, exposure is the act of light affecting the film or a sensor, and there are three aspects that dictate the resulting affect of the light. The first is known as ISO speed. The ISO speed refers to the sensitivity of the film or sensor. A larger ISO speed corresponds to a greater sensitivity to light. The second aspect affecting the exposure is the aperture. This corresponds to the size of the opening that allows light to pass to the film or sensor. This value is referred to as F-stop, and smaller values equate to a larger opening, and thus more light. The last component that will contribute to the exposure is the Shutter Speed. The shutter speed is the amount of time that the light is allowed to affect the sensor. A longer amount of time will allow in more light, leading to a brighter image.

Adjusting Exposure
Now that we know what determines the exposure how do go about properly adjusting it for our image. This can be done through either of the three parameters: ISO, Aperture, or Shutter Speed. In order for these parameters to have an affect on the exposure of the image Exposure must be checked in the physical camera settings. Depending on some of the other affects that are being used adjusting the camera via one parameter might be more appropriate than another.
**Using Aperture**

When using aperture to adjust exposure remember that there is an inverse relationship between the value and the result. Meaning that a small value will increase the brightness of your scene, and that a large value will decrease the brightness of your scene. If you have depth of field enabled, then the aperture value will determine how much depth of field will be in your scene. A smaller value will create a narrow depth of field, in which objects will have to be closer to the focal distance of the camera in order to stay in focus. A larger value will create a greater depth of field. This will allow objects to stay in focus even if they are farther away from the focal distance. If you are trying to get achieve a particular depth of field, then it is recommended that you adjust the exposure through the shutter speed or the ISO setting.

F-Stop = 6  
F-Stop = 8  
F-Stop = 12

**Using Shutter Speed**

Shutter speed can be another good way to adjust the exposure of your image. The parameter itself actually expresses itself as $1/x$. In other words inputting a value of 4 actually means a shutter speed of one quarter of a second. Therefore a larger value actually means that the shutter speed is faster, and that will translate to a darker image. If you are doing any animation, with either moving objects, a moving camera, or both and also have motion blur enabled then the shutter speed will have a direct effect on the amount of motion blur. A longer shutter speed will cause a greater amount of motion blur, where as shorter shutter speed will decrease the amount of motion blur. The amount of blurring will also be determined by the speed of the objects as well. If you are trying to have a certain amount of motion blur, then it would be advised to test different shutter speeds until the right amount of blurring occurs, and then adjust for exposure with either aperture or ISO value.

Shutter Speed = 60  
Shutter Speed = 100  
Shutter Speed = 180
Using ISO
The ISO value is extremely useful for exposing a scene. With rendering the ISO value does not have any side effects or byproducts like aperture or shutter speed. This allows you to tailor the other parameters to the needs of your scene, and the ISO can act as the determining factor in the final exposure of the image. This would be extremely useful to properly expose a scene with both depth of field and motion blur. The ISO values are also have a linear relationship which is not the case with both aperture and shutter speed. For ISO values a larger number will also mean a brighter image, which may be easier to remember.

Adjusting white balance
The white balance feature allows you to compensate for the color of the lighting of a scene by determining which color V-Ray interprets as white. This can be very useful for counterbalancing the color of the V-Ray sun, accurate color matching for placing rendering in a photo, or a quick and simple adjustment of the tone of an image. Typically colors used for adjusting the white balance of an image are lighter and under saturated.
The V-Ray Sun and Sky are based off of research to accurately depict the sun and sky, which allows for easy recreation of the Sun and Sky. They are intended to work together as well as react to the angle and direction of the sun. Add to add a V-Ray sun type Sunlight into the command line. This will bring up the Sun Angle Calculator. This will allow you to input time, day, and location. Once you’ve set your desired parameters, click Okay and it will ask for an insertion point. Any place is fine for the sun, so don’t worry too much about where you put it. With the light selected open up the light properties and you will see all of the parameters for the V-Ray sun.

### Using the Sun with the V-Ray Physical Camera

In order to properly use the sun, it is a necessity that it be used in conjunction with the Physical Camera. The Sun itself is extremely bright, and in order to maintain the characteristics of the model, the sun must be kept close to its correct intensity. To counteract the intense brightness of the sun it is important to create a proper exposure of a scene with the physical camera. Using the physical camera will also help accurately capture the correct colors of the sky as well.

### Accessing the Sun Properties

You can access the properties of the sun by selecting it then selecting Light under object properties. Here you will find many different controls which change the appearance and affect of the sun. For right now we will maintain the default value.

### Exposing Your Scene with the Physical Camera

Since the best way to make use of the Sun is to also use the physical camera, access the V-Ray Options and in the Camera rollout enable the Physical Camera. To determine the correct exposure you will need to do a quick render of the image. If your image is too bright, or overexposed, then you will need to adjust the F-stop, shutter speed, or ISO value to compensate. It maybe helpful to view the color values in Float format, as this will help you determine the true brightness of your image. This can be viewed by right-clicking and holding anywhere in the frame buffer.

The image to the left was rendered using the V-Ray Sun and the Physical Camera. This image used the following values to achieve the correct exposure: F-Stop= 16, Shutter Speed= 200, ISO= 200

If you do not want to use the physical camera it will be necessary to decrease the intensity of the sun by a significant amount, however, the sun and sky may not act in the way it was designed.
Adding the V-Ray Sky
Previously we were simply dealing with the only the V-Ray Sun, but now let's go ahead and add the V-Ray sky. In the environment rollout of the V-Ray options, click on the "m" next to GI parameters. You must have Indirect Illumination enabled to access this, so enable it if you have not already. Clicking the "m" should bring up the texture editor, and under Type select Sky. At the top you will notice the option to select a light source. Click on that button and select the light that was created via the sunlight command. Now V-Ray knows where the sun direction is coming from, and this is an important step for having the Sun and the Sky working together. Lastly, there is an option next to the button that says Override Sun's Parameters. This allows separate settings for the Sun and the Sky, but for simplicity and continuity it is recommended to have this unchecked. Now go ahead and repeat this process for the background. If we render again we'll notice that our white ground plane has a slightly blue hue to it. This is due to the influence of the sky on our scene.

Time of Day and the Sun's appearance
Now that we have added the sun and sky, let's see how the sun reacts to changing the time of day. In order to change the position of the sun, select the sun and go to the light properties. At the top of the window is a button named Modify. Click on the button and it will bring up the Sunlight window and you can change the position. Now the appearance of the scene has completely changed solely based on the position of our sun. This allows users the flexibility to worry only about the time of day rather than adjusting the appearance and intensity of the sun and the background.

Changing the Sun's Appearance with Turbidity
Although the time and position of the sun will have the most affect on the appearance of the Sun and Sky, there are several other controls that will be helpful in adjusting their appearance. Turbidity essentially changes the amount of dust that is in the air. Values on the lower end of the spectrum will create a very clear blue sky as you would see in the country side. Having larger values will make the sky slightly yellow or orangish as you would see in the city. Think of turbidity almost as a control for the haziness of the sky.

<table>
<thead>
<tr>
<th>Turbidity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Clear Day</td>
</tr>
<tr>
<td>5</td>
<td>Slightly Hazy</td>
</tr>
<tr>
<td>8</td>
<td>Very Hazy Day</td>
</tr>
</tbody>
</table>
changing the sun’s appearance with ozone

the other useful parameter in adjusting the sun is ozone. ozone changes the color of the sun itself from a slightly yellow tone to a slightly blue tone. this can be very useful for fine adjustments to the appearance of the sun.

<table>
<thead>
<tr>
<th>Ozone= 0</th>
<th>Ozone= 0.5</th>
<th>Ozone= 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image 1" /></td>
<td><img src="image2.png" alt="Image 2" /></td>
<td><img src="image3.png" alt="Image 3" /></td>
</tr>
</tbody>
</table>

gamma correction and the v-ray sun and sky

due to the physical nature of the sun and sky model it is intended to be rendered using a gamma corrected linear workflow. gamma correction compensates for a monitor’s tendency to display mid-tones darker than they actually are. most programs embed the correction for this into the image, but because of the nature of how v-ray processes color information it does not correct for this. ultimately the result is that the vray sky will appear too dark if it is not corrected for display on our monitors. also if the image is not gamma corrected the influence of the sky will not be accurate either. needless to say, gamma correction is very important, extremely so when using the v-ray sun and sky.

the image on the far left is has no gamma correction. this causes the sky to be dark and its colors to be inaccurate. the closer image has been gamma corrected, which brightens the sky as well as having colors which accurately represent the sky’s influence.

enabling gamma correction

in order to gamma correct images both the inputs (textures and colors) and output need to be adjusted. this is very quick and simple to do in the with v-ray as well as not impeding on workflow. in global switches, there is a section in the bottom right corner containing the controls for gamma correction. to adjust the inputs check correct rgb and correct ldr textures. to adjust the output change the gamma value from 1 to 2.2
Liquid Inside Transparent Glass

Strange image

This problem is actually due to the way the model is made as opposed to a specific setting. Open file Cup-Liquid.3dm. The liquid and the inside of the glass are coplanar, this will cause problems when determining which surface to render. Render it and you will get image as below.

Use Scale or Scale2D to increase the size of liquid and that will solve the problem.

If the liquid is scaled down you will get the result as if the liquid is contained within a very thick glass. This version is not as realistic as the rendering above.
**Caustics**

**What are Caustics?**
Caustic is a lighting phenomena created by some materials, for example, metal, glass and liquid which either reflect or refract light around the object. This happens when the light becomes focused by the materials resulting in a pattern of bright light.

Open file: **Cups-Caustics.3dm**, open V-Ray for Rhino's Render Options. Pull down the Caustic control panel at the bottom. Check the on to open the Caustic effect.

At the beginning of the render the progress window will say that it is calculating caustics. Depending on the number of lights and the caustic subdivisions of each light this process may be very quick or take a few minutes.

**Examples**
Image on the left is rendered without Caustic effect. Image on the right is rendered with it. The values of Max Photons, multiplier, and Caustic Subdivs are all using default setting. With the image on the left you can see a slight caustics effect. This is due to the Affect Shadows option. This option is actually trying to fake the caustics effect seen on the right.
Go back to the Caustic's control panel. Render it again with the Max Photons changed from 50 to 300, as the image on the right. Compare with last page you will find the Caustic effect is greater this time and smoother.

Usually it's easier to spot the Caustic effect in a darker scene. If the scene is brighter, you can try increase the Multiplier to offset the difference.

If you want to control the quality of Caustic even better, other than increase the intensity of light, you can also increase the Subdivs under Sampling from 1000 to 2000 or even higher. But this will increase the prepare time for render Caustic effect.

Image on the right is rendered with Caustic Subdivs set to 3000, you can see the better quality of Caustic effect in this case.
Color Mapping

The Function of Color Mapping
Color mapping is used to adjust how color are actually displayed for a given image. When V-Ray determines a color value for a given pixel this value is then interpreted based on the type of mappings in use. This is very useful for minimizing the amount of an image which is out of the range of what can be displayed on a monitor.

Types of Color Mapping
Open Color Mapping under Options, V-Ray default is set to Reinhard option.

Reinhard is a blend between Exponential Mapping and Linear Mapping. The result is linear mapping when the Burn value is 1.0; and when the is 0.0, the result is Exponential Mapping.

Reinhard Burn value 1
Reinhard Burn value 0.0

Linear Multiply simply means that the color will not be changed from the generated value to the displayed value, like the image on the left.

Exponential is using color intensity to control brightness and prevent wash out situation, but objects' color will become light, like the image on the right.
HSV Exponential and Exponential are very similar, but will keep the tune and intensity of the color, like the image on the bottom left.

Intensity Exponential can maintain the RGB ratio, and will only affect the color intensity, like the image on the bottom right.

Gamma Correction applied to the color a gamma curve. Dark Multiplier is a multiplier for the colors before they are gamma corrected. The inverse of the gamma value is the Bright Multiplies (gamma 2.2 should be 0.4545 in Bright Multiplier). The image is shown on the bottom left.

Instead of applying a gamma curve to each channel (RGB) independently, Intensity Gamma is applied to the saturation of the color. The image is shown on the bottom right.
Adaptive Subdivisions control

The default setting for Adaptive Subdivision can produce a good result. See image below on the left. These thin lines rendered with default Adaptive Subdivisions and had some broken lines in the back.

Adaptive Subdivisions Sampler
Open Image Sampler under Options, V-Ray's default uses Adaptive Subdivisions as its method of calculating antialiasing. Default Min Rate is -1, Max Rate is 2. Similar to the previous discussion about Min Rate and Mat Rate, use proper value to create accurate rendering. For this example, set the Min rate directly to 0 will fix those broken lines, as in the image on the right.

Fix Rate Sampler
Fixed Rate Sampler works in much the same way as the Adaptive Subdivisions sampler does, but it does not have the compacity to use multiple levels of subdivisions. Because of this, the Fixed Rate sampler is generally quite slow, although it does produce very predictable results.

Adaptive DMC Sampler
Adaptive DMC Sampler is a very good sampler and pairs very well with using DMC for primary bounces. Similar to DMC the Adaprive DMC Sampler is best used for scenes with lots of small details. Although Adaptive DMC is not always the fastest method for calculating antialiasing, it typically produces quality results.

Proper Adjustment of the Image Sampler has a direct impact on the speed and quality of the final image. For faster previews you can decrease the Image Sampler quality. For final renders it is very important to have a correct setting because a poor setting can produce a poor quality image even if the lighting calculations are very precise. In all cases higher subdivisions will yield a better quality image.
Mesh Settings

In order for geometry to be rendered, whether it be with V-Ray or in the viewport, a mesh needs to be created. Because Rhino uses NURBS instead of meshes for modeling all of the NURBS geometry must be converted to meshes in order to even appear in the viewport. The good part about using NURBS is that a different mesh can be created from the same geometry; one which is very fine or another which is courser.

Setting a Custom Render Mesh

Access Render Mesh settings by clicking on Rhino Options and under Document properties clicking on Mesh. By default Rhino uses the preset Jagged & Faster. While you are working on your model it is recommended that you use the Jagged & Faster preset. However, when it becomes time to do render final images the Jagged & Faster preset may not produce a fine mesh, which can lead to odd looking renders.

To set a custom mesh click custom and the options below will become active with whatever were the previous mesh settings. The most effective way to create a mesh is by defining only a few of the parameters and letting Rhino figure out the rest. First change all of values to 0 except Maximum distance, edge to surface which should be set close to the tolerance value for your scene. Now set one of two different parameters, Maximum angle or Maximum Edge length. The best setting for Max angle is usually somewhere between 6 and 12. Maximum edge length will depend on your scene, and usually works well for high detail scenes without many large flat surfaces, such as jewelry. Beware of setting too fine of a mesh as this may take a long time for Rhino to calculate. Below are two examples with the mesh on the left and the rendered result on the right.

The images above are from a very course mesh. Notice how the handle and the rim of the cup look jagged and odd. The images below are from a very fine mesh. Now the cups appear completely smooth.
Resolution of the Image

**Image size setting**

V-Ray can ignore the size set up in Rhino. Open V-Ray for Rhino’s Render Options. Pull down the Output control menu and check the box for Override Rhino to have V-Ray define the image size.

There are several size presets in V-Ray to choose from. User can also set the size themselves. The unit used is pixel. The Image Aspect value is the height-width ratio for current size. Click on the “L” to lock in this ratio. Now when either the height or width is changed, V-Ray will calculate the other value automatically according to this ratio.

**Saving your image**

Check the Save File under the Render Output and then click on the “…” to set up the file saving path, type and file name. When V-Ray finishes rendering, the file will be saved accordingly. Please note that next rendering will override the previous one with the exact same path, type and name.

The Pixel Aspect option controls the height and width ratio of the pixel. Here are two example.
V-Ray Frame Buffer

Render image window tool box
V-Ray will open a render window while rendering an image. There are some important tools in it. Please see explanations below for each tool.

Switch back and forth to different color channels to display the image, which is also including Alpha Channel and grayscale to display the image in black and white

Save the image

Clear the image.

Click this icon to open the pixel information dialog box. Right clicking on the rendering window also displays the pixel information.

This button will allow you to see the time stamp functions. Click the button to add the stamp to the image.

Mouse Operation
Ctrl+ Left click > Zoom in
Ctrl+ Right click > Zoom out
Double Click > 100 percent
Middle Wheel > Zoom in/out

Keyboard Operation
+/-> Zoom in/out
Arrow Keys move around the image

By clicking on this icon V-Ray will render where the mouse is pointed to first during the last pass of rendering process (see image above). This is very helpful for those who want to see the final result of particular part of the image. If the result is not what you want, hit ESC to end rendering process right away.

Opens the V-Ray Color corrections box. From here you can adjust curves, levels, and exposure. In order to see the effects you must click the corresponding icon.

Curves
Exposure
Levels
Distributed Rendering is the capability to render a single image across multiple computers. This has the possibility of utilizing multiple computers which can greatly increase rendering speed. V-Ray can use up to ten computers with just one license.

In order for V-Ray to utilize these extra machines there are two things that need to be done. First, there are needs to be a way for V-Ray for actually use the other machine. Secondly, V-Ray needs to be told to look for those machines.

**Setting Up the V-Ray Distributed Rendering Spawner**

The way in which V-Ray communicates with other computers (known as the slave machines) is through a stand alone application which is installed and run on the slaves. Any machine which has V-Ray for Rhino installed on it should have the Distributed Render Spawner already on the machine. If it does not, or you would like to install the DR Spawner that does not have V-Ray for Rhino you will need to access your installation file or disk. Once the installation is started you will need to choose Custom setup type. Within the custom setup there will be four components, one of them being the DR Spawner. Disable all of the other components and click next to install the DR Spawner.

**Finding the IP address of the slave computer**

The last piece of information that you will need in order to utilize the slave machine is the IP address. You can get this one of two ways. The first is to go to Network and Internet Connections in the Control Panel. From there double click on Network Connections. This will bring you to a window containing all of your internet connections. Double click on the connection you intend to connect through and that will bring up dialog box containing the status of that connection. At the top, click on the second tab labeled Support. Take note of the IP address as you will need this information in a few moments.

The second way of retrieving your IP address is to use the run command. You can get this by going to the start menu and clicking on Run. Now type IPCONFIG which will tell you the IP address of you machine. If your computer only flashes the result, than you can type CMD.EXE into the Run window and then IPCONFIG in the resulting DOS interface.
**Starting the DR Spawner**

Once the DR Spawner is installed on the slave machine you will need to start the application. In the folder C:\Documents and Settings\All Users\Application Data\ASGvis you will find a folder called DRSpawner. Open that folder and you will find the DR Spawner. Double clicking on the DR Spawner will launch it, and once it has successfully loaded the Spawner it is ready to go.

![DR Spawner Image](image1)

**Connecting to Slave Machines**

Now that the slave machines are ready to go we need to tell the main computer that we are render from, also known as the client, not only that we will be using other computers to render but also how to access them. This is very simple as well. Within the Systems rollout of V-Ray’s options you will see a checkbox and button for Distributed Rendering. To enable Distributed Rendering simply click the checkbox next to the button. Clicking on the button will bring up a window which will allow you to input the IP addresses of any slave machines you wish to use. Within the Distributed Rendering window at the top you will notice the option to Add a Server. This is where you will input the IP addresses of any machines that you will connect to. After you input any IP addresses you will want to click Resolve servers.

![Distributed Rendering Settings](image2)

**Some Considerations For Distributed Rendering**

With using Distributed Rendering you might run into several possible issues. When trying to connect to slave machines you may have issues of not actually getting them to render. Check any firewalls that may be on the host or slave machine as well as any routers that you may have. Also, textures will not be transferred to the host machine by the DR software. Optimally, textures should be in a single network location that is accessible to all machines being used, but if this is not possible then you must manually transfer the textures manually to a folder on the slave machine(s) that is the same path as on the host machine. Also, if you have the capability to use Remote Desktop Connection or a similar software, it may make the task of monitoring slave machines an easier task.
Sample Materials

Rubber - Orange
Rubber - White
Sculpture - Gray_Bump

Water
Wax - Green
Wax - Skin

Argil - Brown_Bright
Argil - Brown_Dark
Argil - Red

Carbon Fiber
Ceramic - Red
Ceramic - White

V-Ray for Rhino105
- Chocolate
- Crystal
- Eggshell
- Emmisive
- Glass - Black
- Glass - Frosted
- Glass - Pure
- Granite - Brown
- Granite - Sunsetbeige_Dark
- Granite - Sunsetbeige_Light
- Gypsum
- Gypsum - Bump
Sculpture - Gray Dot  Sculpture - White Dot  Lolipop

Wood - 01

V-Ray for Rhino109